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Методические рекомендации по выполнению практических работ (заданий) 

(далее – Методические рекомендации) предназначены для студентов, обучающихся 

по программе подготовки специалистов среднего звена по специальности 54.02.01 

«Дизайн (по отраслям)». 

Методические рекомендации разработаны в соответствии с требованиями 

ФГОС СПО к условиям реализации программы подготовки специалистов среднего 

звена. Методические рекомендации содержат пояснительную записку, содержание 

практических работ, информационное обеспечение. 
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1. ПОЯСНИТЕЛЬНАЯ ЗАПИСКА. 

 

Методические рекомендации по выполнению практических заданий/ лабораторных работ 

(Далее – Методические рекомендации) по учебной дисциплине составлены в соответствии 

с требованиями ФГОС СПО и рабочей программой учебной дисциплины ОП.09 Дизайнерское 

проектирование в графическом редакторе для обучающихся по специальности 54.02.01 Дизайн 

(по отраслям) 

В результате освоения дисциплины обучающийся должен: 

знать: 

− правила и принципы творческого решения дизайнерской задачи; 

− современные тенденции, классификации и свойства основных материалов, их виды и 

применение в дизайне; 

− методы изобразительного языка для передачи творческого художественного замысла 

проекта;  

− общие требования к спецификации и выполнению дизайн-проектов, этапы 

проектирования,  

− основы теории и методологии дизайн-проектирования;  

уметь: 

− выражать свои замыслы и идеи графическим способом;  

− преобразовать концептуальную идею в графический вид;  

− выбирать материалы в зависимости от их формообразующих свойств при проектировании 

объектов дизайна; 

− анализировать и определять требования к дизайн-проекту и синтезировать набор 

возможных решений задачи или подходов к выполнению дизайн-проекта;  

− решать основные типы проектных задач; 

формировать компетенции: 

ПК 1.1. Разрабатывать техническое задание согласно требованиям заказчика; 

ПК 1.2. Проводить предпроектный анализ для разработки дизайн-проектов; 

ПК 1.3. Осуществлять процесс дизайнерского проектирования с применением 

специализированных компьютерных программ; 

ПК 5.1. Выполнять эскизы с использованием различных графических средств и приемов. 

ПК 5.2. Создавать графические дизайн-макеты на основе технического задания. 

ОК 01. Выбирать способы решения задач профессиональной деятельности применительно к 

различным контекстам; 

ОК 02. Осуществлять поиск, анализ и интерпретацию информации, необходимой для 

выполнения задач профессиональной деятельности; 

ОК 03. Планировать и реализовывать собственное профессиональное и личностное развитие; 

ОК 04. Работать в коллективе и команде, эффективно взаимодействовать с коллегами, 

руководством, клиентами; 

ОК 05. Осуществлять устную и письменную коммуникацию на государственном языке 

Российской Федерации с учетом особенностей социального и культурного контекста; 

ОК 09. Использовать информационные технологии в профессиональной деятельности; 

Методические рекомендации по дисциплине предназначены для помощи обучающемуся при 

выполнении практических заданий и лабораторных работ на занятиях, и при подготовке к 

практическим и лабораторным занятиям. 

Приступая к выполнению задания на практическом (лабораторном) занятий, обучающийся 

внимательно изучает цель и задачи занятия, знакомится с теоретическими и учебно-методическими 

материалами по теме практического (лабораторного) занятия, и отвечает на вопросы для 

закрепления теоретического материала. 

Каждое описание практической работы содержит цель, перечень оборудования, порядок 

выполнения задания. 

Подготовка к практическим занятиям заключается в изучении теории на занятиях 

теоретического обучения и самостоятельного изучения дополнительной, рекомендованной 

литературы, предусмотренной рабочей программой. 
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Практическая работа считается выполненной, если она соответствует критериям оценки: 

Оценка «отлично» ставится если, студент демонстрирует:  

– сформированность терминологического аппарата; 

– владение системой знаний на уровне осознанного применения при выполнении учебных/ 

учебно-профессиональных действий; 

– оригинальность решения, в том числе при решении нестандартных задач; 

– гибкость, системность, глубину мышления; 

– применение методов, адекватных поставленной цели и задачам; 

–выполнение работы в логической последовательности; 

– грамотное использование символики и графических средств; 

 – проявление высокого уровня самостоятельности; 

– от 90% до 100% правильность выполнения практической работы. 

Оценка «хорошо» ставится если, студент демонстрирует:  

– сформированность терминологического аппарата;  

– владение программным материалом для выполнения учебных/ учебно-профессиональных 

действий, 

 –  применение освоенных алгоритмов в типовой (знакомой), ситуации; 

– применение методов, адекватных поставленной цели и задачам; 

– выполнение работы в логической последовательности; 

– грамотное использование символики и графических средств; 

 – выполнение практической работы самостоятельное; 

 – правильность выполнения – от 70% до 89%. 

Оценка «удовлетворительно» ставится если, студент демонстрирует:  

– недостаточную сформированность терминологического аппарата; 

– недостаточное владение программным материалом для выполнения учебных/ учебно-

профессиональных действий;  

–  применение освоенных алгоритмов в типовой (знакомой), ситуации с незначительными 

нарушениями; 

– применение нерациональных методов для выполнения практической работы; 

–отступление от логической последовательности при выполнении работы; 

– неточность использования символики и графических средств; 

– проявление недостаточного уровня самостоятельности (выполнение работы с помощью 

преподавателя); 

–правильность выполнения – от 51 % до 69%. 

Оценка «неудовлетворительно» ставится если, студент демонстрирует:  

– недостаточную сформированность либо несформированность терминологического 

аппарата; 

– недостаточное владение программным материалом для выполнения учебных/ учебно-

профессиональных действий; 

– применение освоенных алгоритмов в типовой (знакомой), ситуации со значительными 

нарушениями; 

– применение нерациональных методов для выполнения практической работы; 

– нарушение логической последовательности при выполнении работы; 

– неточность использования  

символики и графических средств; 

– проявление недостаточного уровня самостоятельности (выполнение работы с помощью 

преподавателя); 

– правильность выполнения – менее 50 %. 

Наличие положительной оценки по практическим работам необходимо для успешного 

прохождения промежуточной аттестации по учебной дисциплине, поэтому в случае отсутствия на 

занятии по любой причине или получения неудовлетворительной оценки за практическую работу, 

обучающийся должен устранить долг по данной работе. 
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2. СОДЕРЖАНИЕ ПРАКТИЧЕСКИХ РАБОТ. 

 

Практическая работа 

 

Порядок выполнения упражнения: 

Определитесь с будущей формой, элементами и композицией расти- тельного орнамента, сделав 

набросок на бумаге. Импортируйте его или готовое изображение в CorelDraw. 

Теперь поверх наброска или отсканированного скетча аккуратно нари- суйте линии 

инструментами Bezier (Безье) или Pen Tool (Перо). Они должны быть незамкнутыми линиями, а не 

объектами, это пути для кистей. 

С помощью инструмента Artistic Media (Художественное оформление (I)) нарисуйте основные 

элементы орнамента: листики, цветочки и другие дета- ли для оформления. Объекты редактируем 

с помощью инструмента Shape (Форма (F10)). 

Выполните композиционное построение и цветовое оформление орна- мента (рис.1). 

 
Рис. 1. Примеры выполнения элементов растительного орнамента. 

Порядок выполнения упражнения: 

Импортируйте в CorelDRAW растровое изображение (Основное меню: File (Файл)/ Import 

(Импорт) или комбинацией клавиш «Ctrl+I»). Поместите импортированный объект в центр 

страницы (с помощью команды основного меню или клавиши «P»). 

Увеличьте изображение для удобства работы. Обведите изображение объекта замкнутым 

контуром, воспользовавшись инструментами для рисования линий. 

Исходное растровое изображение удалите. Залейте объект цветом. Ис- пользуйте шесть видов 

заливки объектов в CorelDraw: однородная, градиентная заливки, заливка узором, текстурой, 

интерактивна заливка, заливка по сетке. Для выбора вида заливки предназначен инструмент Fill 

(Заливка), который располагается в докере с правой стороны экрана «Свойства объекта» (рис. 2). 

 
Рис. 2. Создание векторного объекта на основе растрового. 

Упражнение 4 

Цель – овладение техникой заливки векторных объектов. 

 

Упражнение 5 

Формирование фигур 

Задача – создать векторную иллюстрацию. 
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Порядок выполнения изображения: 

Создайте документ формата А4. Импортируйте растровое изображение. 

С помощью инструментов группы Freehand (Свободная форма (F5)) об- ведите контуры 

изображения разными цветами. 

Заполните созданные формы цветом. 

Удалите растровое изображение. 

Сгруппируйте объекты (рис. 3). 

 

 
Рис. 3. Векторная иллюстрация со стилизованными линиями. 

Цель – овладение техникой построения объектов из простых геометриче- ских фигур. 

Задача – создать декоративный орнамент из простых геометрических фи- гур: прямоугольников, 

эллипсов и др. 

Существуют различные виды орнаментов. Они бывают растительными, предметными, 

пейзажными, астральными, цветочными, фантастическими, кал- лиграфическими и др. Все 

зависит от того, из каких элементов выполняется узор. Геометрический орнамент состоит из 

простых фигур — круга, квадрата, прямоугольников, треугольников. Это самый 

распространенный и легкий для построения вариант. Чтобы его сделать, достаточно понимать 

закономерность построения орнаментов. 

Любой узор, геометрический, растительный, имеет определенный мотив и раппорт. Мотив – это 

главный элемент орнамента. Он бывает простой, со- стоящий из одной формы с единым контуром, 

или сложный, который предпо- лагает наличие нескольких составных частей. В качестве мотива 

может высту- пать стилизованный цветок, лист, звезда, разные виды многоугольников, звезда, 

состоящая из треугольников. Раппорт представляет собой совокупность мотива или их группы и 

расстояния до соседнего. 

Каждый узор, геометрический, растительный или любой другой, пред- ставляет собой 

определенный ритм, то есть повторение, чередование опреде- ленных элементов. В качестве 

мотива можно взять равнобедренный треуголь- ник. Многократно повторите его по горизонтали 

без промежутков, тогда полу- чатся своеобразные зубчики, на одинаковом расстоянии или чередуя 

длину пространства между элементами в определенной комбинации. Вид ленточного орнамента 

будет меняться. То же самое можно сделать по вертикали. 
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Чтобы создать сетчатый узор, достаточно полученную на первом этапе строчку из треугольников 

повторить несколько раз в столбик. Каждый модуль 

может находиться как один под другим, так и со смещением. Два разных гори- зонтальных ряда 

чередуются по определенной закономерности. 

 

Упражнение 6 

Обработка линий и фигур 

Оригинальные декоры получаются при комбинации различных видов от- зеркаливания. По 

горизонтали или вертикали отражаются строчки, столбцы или только их части в определенной 

комбинации. Центрические геометрические орнаменты и узоры получить также легко. Достаточно 

выбрать точку вращения на одном из концов элемента, внутри него или за пределами и вокруг нее 

сдви- гать треугольник на определенное количество градусов. 

Порядок выполнения упражнения: 

Из геометрических фигур составляете базовый элемент. Выполняете операцию группировки 

частей. 

Копируете модуль. Вставляете нужное количество раз. Строка готова. 

Группируете ее так же, как и сам модуль вначале. Пробуете различные комбинации отражений, 

повторений. Можно даже сделать вращение по окруж- ности с разным углом поворота. 

Раскрасьте орнамент, используя различные варианты заливок (рис. 4). 

 

 

 

 

Автор: студент 487 гр. М. Саяпина     Автор: студент 487 гр. Е. Фуфарева 

 

 

Рис. 4. Примеры выполнения элементов растительного орнамента. 

Цель –  овладение техникой  обработки  линий  и  фигур  инструментом 

Shape (Форма). 

Задача – создать рисунок бабочки, используя инструмент Shape (Форма (F10)). 

Порядок выполнения упражнения: 

Нарисуйте тело бабочки. Возьмите инструмент Ellipse (Эллипс (F7)). Постройте два объекта 

туловища бабочки, далее преобразуйте их в кривые (правая кнопка мыши по эллипсу, в 

появившемся меню выбрать 

«Преобразовать в кривую»). Теперь возьмите инструмент Shape (Форма (F10)). Добавляя новые 

узлы и перемещая старые либо изменяя тип узлов, или перемещая опорные точки данных узлов, 

видоизмените эллипсы. 

Таким же образом, используя эллипс, постройте глаза и усы будущей бабочке. 

Нарисуем крылья бабочки. Решить данную задачу можно как минимум двумя способами. 

Первый способ: возьмите инструмент Polyline (Ломаная линия). Далее постройте ломаный, 

упрощенный контур крыльев. Возьмите инструмент Shape (Форма). Выделите все узлы. Кликните 

правой кнопкой мыши, не снимая выделения, по любому из узлов. В появившемся меню выберите 

пункт «Преобразовать в кривую». После данной операции, отредактируйте инструментом Shape 

(Форма) сегменты. 
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Второй способ: в основе его лежит использование инструмента Pen (Перо) либо Bezier (Безье). 

При помощи данного инструмента можно построить контур крыльев за один раз. 

Постройте кайму в левой части крыльев бабочки. Создайте копию крыла (выделить объект и 

нажать клавишу «+»). Сместите немного копию крыла влево. 

Постройте объекты, имитирующие прожилки на крыльях бабочки. Для этого можно 

воспользоваться инструментом Freehand (Свободная форма (F5)), Polyline (Ломаная линия) или 

Bezier (Безье). Также инструментом Ellipse (Эллипс (F7)) постройте небольшие чередующиеся 

пятна на краях крыльев. 

Раскрасьте бабочку, используя инструменты для заливки объектов (рис. 5). 

 
Рис. 5. Пример построения бабочки. 

 

 

Упражнение 7 

Цель – овладение техникой  обработки  линий  и  фигур  инструментом 

Shape (Форма). 

Задача – создать гроздь винограда, используя инструмент Ellipse (Эллипс (F7)) и инструменты для 

рисования линий. 

Порядок выполнения упражнения: 

Выберите инструмент «Эллипс» и нарисуйте виноградинки. Одну из виноградин залейте 

фиолетовым цветом. Остальные виноградины сделайте темнее или светлее, экспериментируя с 

оттенками и размерами. 

Добавьте к созданным виноградинкам блики, используя инструмент 

«Эллипс», заливку и эффекты перетекания или прозрачности. 

Теперь нарисуйте листик винограда. Сделайте два клика по инструмен- ту Shape (Форма (F10)) – 

выделяются все узлы. Отредактируйте контура листи- ка с помощью инструмента Shape (Форма 

(F10)). Залейте его зеленым цветом. 

Теперь скопируйте листик несколько раз. Разместите их на рисунке, накладывая друг на друга, 

перемещая и раскрашивая их в разные оттенки, для того чтобы повысить разнообразие. Также 

листья можно вращать, переворачи- вать и по-разному деформировать. 

Создайте веточки винограда, выделите одну из них. Измените форму объекта. Проделайте то же с 

остальными объектами, размещая их в необходи- мом порядке. 

Нарисуйте прожилки у листочков винограда, изменяя форму объектов с помощью инструмента 

Shape (Форма (F10)). 

Получившееся элементы разместите на рисунке, изменяя порядок их расположения, спрячьте 

виноградинки под «листву» (рис. 6). 
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Рис. 6. Пример рисования грозди винограда. 

Практическая работа 

Порядок объектов. Выравнивание и группировка. Создание новых форм объектов 

3. Перемещаем созданный объект на 45 градусов. Создаем копию фигуры и выполняем смещение 

(рис. 9). 

Упражнение 8 

Цель – овладение техникой создания новых форм объектов из простых геометрических фигур. 

Задача – создать паучка из простых геометрических фигур – эллипсов. 

Создайте окружность размером 40x40 мм (рис. 7). Для вызова контек- стного меню нажмите 

клавиши «Alt»+F8. Создайте копию окружности с при- вязкой к центру, уменьшив изображение на 

60%. 

 
 

Рис. 7. Создание окружностей. 

Выделите большую окружность. Создаем на ее основе сектор 270 гра- дусов (рис. 8). Выделяем 

меньшую окружность, удерживая кнопку Shift, выде- ляем большую окружность. В строке свойств 

выбираем команду Merge (Объе- динение). 

 
Рис. 8. Построение новой формы объекта на основе двух простых фигур. 

13 
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Рис. 9. Создание копии фигуры со смещением. 

 

 

Используем инструмент Shape (Форма) для корректировки контура скопированного объекта. 

Выделяем оба объекта и выполняем команду Trim (Подгонка). Получаем два новых объекта (рис. 

10). Нижний надо удалить. За- ливаем контур паучка черным цветом, растягивая фигуру вниз. 

 
 

Рис. 10. Основной контур паучка. 

 

 

14 

Создаем копию получившейся фигуры. Изменяем ее в соответствии с рисунком 11. 

 

 
Рис. 12. Заливка фигуры. 

 

 

 

 

 

Рис. 11. Паучок. 
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Упражнение 9 

Цель – овладение техникой создания новых форм объектов из простых геометрических фигур. 

Задача – создать рисунок птицы из простых геометрических фигур. 

Порядок выполнения упражнения: 

Создайте новый документ формата А4. 

Нарисуйте форму тела птицы  с помощью  инструмента  Free  Hand 

(Свободное рисование). 

отредактируйте контур объекта с помощью инструмента Shape Tool 

(Форма). 

Скопируйте объект и оставьте его на том же месте.Залейте первую фи- гуру темно-синим цветом, 

а вторую – радиальной заливкой с переходом от си- него цвета к более светлому его оттенку (рис. 

12). 

 

Скопируйте форму и поместите ее в чистой области. Скопируйте ис- ходную еще раз, увеличив 

получившуюся фигуру (рис. 13 а). Расположите фи- гуру на предыдущем объекте. Выделите обе 

фигуры и выполните команду Trim (Подгонка). Залейте сложную форму объекта темно-синим 

цветом. Расположи- те полученный объект на первом. Проделайте операцию несколько раз для 

соз- дания 3D-эффекта (13 б). 

 
Рис. 13. Создание сложной формы объекта. 

 

 

Нарисуйте вспомогательную окружность и расположите ее, как показа- но на рис. 14 (а). Выделите 

окружность и первый объект. Выполните команду Intersection (Пересечение). Нарисуйте вторую 

вспомогательную окружность и 

расположите ее, как показано на рис. 14 (б). Создайте нижнюю часть птицы, используя команду 

Intersection (Пересечение). Нарисуйте глаз будущей птице. 

 
 

Рис. 14. Создание контура будущей птицы. 

С помощью инструментов Free Hand (Свободное рисование), Shape Tool (Форма) и команды Rear 

minus front (Задние минус передние) нарисуйте ресницы, лапы, крылья и клюв (рис. 15). 
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Рис. 15. Создание деталей будущей птицы. 

 

 

С помощью инструментов Ellipse (Эллипс), Shape Tool (Форма) и ко- манды Rear minus front 

(Задние минус передние) нарисуйте шляпу (рис. 16) 

 

 
 

Рис. 16. Создание птицы. 

 

 

Практическая работа  

Создание эффектов. Интерактивные инструменты 

Практическая работа  

Цель – приобретение навыков работы с интерактивными инструментами. 

Задача – создать шар. 

Порядок выполнения упражнения: 

Создайте документ формата А4. Создайте круг нужного размера, удер- живая клавишу «Ctrl». 

Продублируйте его,  выбрав  команду  «дублировать»  из  меню  Edit 

(Правка). 

З. Закрасьте один из кругов черным цветом, а для другого подберите под- ходящую текстурную 

заливку из диалога «Текстура», запускаемого из вспомо- гательного меню инструмента Fill 

(Заливка). 

Удалите контур обоих кругов, выделив их и щелкнув на перечеркнутый квадратик вверху палитры 

правой кнопкой. 

Совместите оба объекта так, чтобы черный круг оказался под текстур- ным: Arrange 

(Упорядочить)/ Order (Порядок)/ To back (На задний план). 

Для совмещения объектов удобно будет воспользоваться командой Align and distribute 

(Выравнивание и распределение) из меню Arrange (Упо- рядочить) – по центру, по горизонтали, 

по вертикали. Предварительно должны 
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быть выделены оба объекта (используя инструмент Pick (Указатель) выделите область, захватывая 

оба круга, либо тем же инструментом поочередно щелкни- те на объекты, удерживая клавишу 

Shift). 

Теперь выберите инструмент Interactive Transparency Tool (Интерак- тивная прозрачность). Из 

списка на панели свойств выберите радиальный градиент прозрачности. Перенесите центр 

интерактивного элемента в верх- нюю левую часть круга. Перенесите при помощи мыши (из 

палитры в правой части окна) цвета – черный на конец радиуса в белый квадратик, а белый цвет – 

в центр заливки, который окрашен в черный цвет. Откорректируйте размеры интерактивного 

элемента, перетаскивая квадратик на конце линии градиента. 

 

 

 

 

 

 

 

 

 

 

 

 

Упражнение 12 

 

 

 

 

 

 

 

 

 

 

Рис. 17. Создание вазы. 

Шар готов. Осталось с помощью инструмента Interactive shadow (Ин- терактивная тень) добавить 

тень к шарику. 

 

Практическая работа  

Цель – приобретение навыков работы с интерактивными инструментами. 

Задача – создать вазу. 

Порядок выполнения упражнения: 

В новом документе нарисуйте эллипс. Залейте его коническим гради- ентом. Уберите обводку 

(щелкните правой кнопкой мыши на перечеркнутом квадратике цветовой палитры) 

Сделайте копию эллипса, сдвиньте ее вниз, немного уменьшив размер. 

Сделайте еще одну копию овала, разместите ее еще ниже. Размер ее будет самый меньший из всех. 

Создайте еще одну копию, но размером больше, чем предпоследняя (рис. 17а). 

Теперь сделайте интерактивное перетекание между овалами. Количест- во шагов перетекания 

поставьте 30-40 (рис. 17б). 

Сделайте копию верхнего эллипса, чуть уменьшив размер, залейте его линейным градиентом (рис. 

17в). 

Цель – приобретение навыков работы с интерактивными инструментами. 

Задача – выполнить рисунок стеклянного бокала. 

Порядок выполнения упражнения: 



АНО СПО «КИТП» 

15 
 

Нарисуйте овал. Залейте его линейной заливкой  бордового  цвета (рис. 18). 

 

 

Рис. 18. Построение овала. 

 

 

Нарисуйте прямоугольник. С помощью инструмента Shape (Форма) со- здайте из прямоугольника 

нижнюю часть бокала. 

Выделите две фигуры и выберите операцию «Исключение». Залейте по- лучившуюся при 

пересечении фигуру радиальной заливкой бордового цвета (рис. 19). 

 
 

Рис. 19. Построение нижней части бокала. 

 

Нарисуйте прямоугольник (это будет фон) и залейте его цветом, гармо- нирующим с цветом 

бокала. 

Нарисуйте еще один овал для бокала с толщиной контура 1 мм белого цвета. Примените к этому 

овалу интерактивную прозрачность с настройками, представленными на рис. 20. 

 

 
Рис. 20. Создание верхней части бокала. 

 

 

Создайте блики. Нарисуйте несколько произвольных фигур, сделайте нулевой контур, а заливку – 

белой. К этим фигурам примените интерактивную прозрачность. Нарисуйте подставку для бокала 

(рис. 21). 

 

 

Рис. 21. Создание бликов и ножки бокала. 

 

 

Сделайте блики на ножке. Залейте их белым цветом и примените инте- рактивную прозрачность 

(рис. 22). 
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Рис. 22. Создание бликов на ножке бокала. 

 

 

Практическая работа  

Цель – приобретение навыков работы с интерактивными инструментами. 

Задача – нарисовать зимний пейзаж. 

Порядок выполнения упражнения: 

Обозначьте  границы   пейзажа.   Для   этого   выберите   инструмент 

Rectangle (Прямоугольник) из набора инструментов. 

Теперь нарисуйте водную гладь: тем же инструментом создайте два прямоугольника, таким 

образом, чтобы один был намного меньше другого. Ок- расьте больший прямоугольник в синий 

цвет, меньший – в голубой. При этом голубой прямоугольник должен примыкать к верхней 

границе синего. 

Затем в получившемся изображении отмените обводку, так как дальше она помешает 

реалистичности. Для этого в группе Outline (Обводка) выберите инструмент No outline (Удалить 

обводку). При этом объект должен быть выде- лен. Далее выберите инструмент Interactive Blend 

(Интерактивное перетека- ние) и примените его к объектам. Количество шагов увеличим до 30. 

Водная гладь готова. Поместим ее в рамку пейзажа. 

Приступим к изображению неба и солнца. Для получения эффекта рас- сеивающегося солнечного 

света выполните следующее: выберите инструмент Rectangle (Прямоугольник) из набора 

инструментов и создайте квадрат. С по- мощью инструмента Shape (Форма) скруглите углы. Затем 

с помощью инстру- мента Pick (Выбор) немного сожмите его по вертикали. 

Увеличенную копию этого объекта растяните по горизонтали. Мень- шую заготовку окрасьте в 

бледно-голубой цвет и расположите в центре боль- шей, окрашенной в голубой. 

Примените к заготовке инструмент Interactive Blend (Интерактивное перетекание), только 

количество шагов уменьшите до 6. В центр полученной заготовки поместите солнце, к которому 

тоже примените Interactive Blend (Интерактивное перетекание) для эффекта мягкости свечения 

(рис. 23). 

 
Рис.23. Создание неба и солнца. 

 

 

Теперь нужно вписать небо в границы пейзажа. Для этого воспользуй- тесь возможностями 

фигурной обрезки. Выделите и сгруппируйте небо с солн- цем. Выберите команду Effects > 

PowerClip > Place Inside Container (Эффекты 

> Фигурная обрезка > Поместить в контейнер). Обратите внимание, что указа- тель превратился в 

черную горизонтальную стрелку. Щелкните на контейнере (рамка пейзажа). По умолчанию объект 

будет помещен внутрь контейнера так, что центр выделения совпадет с центром контейнера. 
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Чтобы изменить положе- ние объекта в контейнере выберите команду. Effects > PowerClip > Edit 

Contents (Эффекты > Фигурная обрезка > Изменить содержимое). Эта операция переключает 

объекты эффекта в режим редактирования. Переместив объект на нужное место, щелкните на 

кнопке Finish editing this level (Завершить измене- ния текущего слоя) в левом нижнем углу окна 

документа). 

Затем пользуясь инструментом Bezier (Кривая Безье), нарисуйте за- снеженные берега и придайте 

им объем при помощи инструмента Interactive Blend (Интерактивное перетекание) (рис. 24). 

 

Рис. 24. Создание элементов пейзажа. 

 

 

Последним этапом нарисуйте с помощью инструмента Shape (Фор- ма) блик на воде. Для его 

окраски примените инструмент Interactive Mesh Fill (Сетчатая заливка). Основной цвет блика – 

бледно-голубой, а некоторые узлы сетчатой заливки окрасьте белым. Пейзаж готов (рис. 25). 

 

 

 

 

Рис. 25. Зимний пейзаж. 

 

 

Практическая работа  

Цель – приобретение навыков работы с интерактивными инструментами. 

Задача – выполнить коллаж на основе растрового изображения. 

Порядок выполнения упражнения: 

Импортируйте растровый портрет в новый документ. 

Нарисуйте два квадрата: белый и серый, чуть поменьше белого. Распо- ложите его в центре 

белого. Сгруппируйте эти квадраты. 

Скопируйте полученные сгруппированные квадраты, распределите их произвольно (рис. 26 а ). 

Возьмите инструмент Smart fill (Интеллектуальная заливка), залейте все серые места 

скомпонованных квадратов (рис. 26 б). 

Выделите с зажатой кнопкой «Shift» все образованные «умной залив- кой» области. Объедините 

их в одну фигуру (рис. 26 в). 

Рис.26. Создание контейнера для коллажа. 

 

 

Выделите портрет, выберите эффект «PowerClip», поместите картинку в контейнер, образованный 

фигурой, сделанной в шаге 5 (рис. 27). 



АНО СПО «КИТП» 

18 
 

 
Рис. 27. Размещение растрового изображения в контейнере. 

 

 

9. Разбейте контейнер PowerClip на отдельные картинки. Добавьте тени к белым рамочкам (рис. 

28). 

 
 

Рис. 28. Коллаж. 

 

 

Практическая работа  

Цель – приобретение навыков создания. 

Задача – создать векторный постер. 

Порядок выполнения упражнения: 

Создайте документ формата А4.  Импортируйте растровое изображение. 

С помощью инструментов группы Freehand (Свободная форма (F5)), Knife (Нож) обведите 

контуры изображения разными цветами, оставляя форму незаполненной. 

Заполните созданные формы цветом. Удалите растровое изображение. 

Напишите текст, подобрав нужный шрифт. 

Сгруппируйте объекты (рис. 29). 
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Рис. 29. Векторный постер. 

Практическая работа  

Цель – приобретение навыков создания и обработки текста. 

Задача – создать календарь. 

Порядок выполнения упражнения: 

Создайте документ произвольного формата. 

Импортируйте красивый фон (Файл/ Импорт). 

Постройте календарную сетку. Нарисуйте таблицу (ширина – 7 дней недели; высота – 5 дней 

недели + 1 сетка для наименования дней). 

Активируйте инструмент Текст, напишите название месяца, и в каждой ячейке поставьте 

календарные числа, соответствующие дням недели. 

Далее удалите обводку календарной сетки. 

Разработайте дизайн календаря, добавляя к нему календарную сетку (рис. 30). 

 
Рис.30. Пример оформления календаря. 

Практическая работа  
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Цель – приобретение навыков создания и обработки текста. 

Задача – создать календарь. 

Порядок выполнения упражнения: 

Для запуска Мастера создания календарей выберите Инструменты – Visual Basic – Запуск. Справа 

откроется диалоговое окно (рис. 31). Из выпа- дающего листа макросов выберите Мастер создания 

календарей и нажмите красную кнопку. 

 
Рис. 31. Запуск Мастера создания календарей. 

 

 

При запуске Мастера откроется диалоговое окно, как на рис. 32. 

 

 

Рис. 32. Диалоговое окно Мастера календарей. 

В левой верхней части окна вы можете выбрать год и месяц создавае- мого календаря. Следующий 

шаг – выбор языка, на котором будут написаны названия месяцев и даты. По умолчанию неделя 

начинается с воскресенья, но вы можете выбрать для начала любой другой день. Нажав на кнопку 

Праздни- ки, вы откроете новое окно (рис. 33). 

 
Рис. 33. Диалоговое окно «Праздники». 

 

 

Одним из недостатков Мастера календарей является то, что в него не загружены праздничные дни, 

так что их придется добавлять. 
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Следующий шаг – вид календаря. В календаре каждый месяц может за- нимать отдельную 

страницу, или весь календарь помещаться на одном листе. Выберите, прежде всего, один из 

вариантов, после чего переходите к осталь- ным настройкам. Если колеблетесь в выборе, выделите 

один из вариантов и по- смотрите, как он будет выглядеть, в окне просмотра. 

Слева внизу есть три вкладки. Первая, открытая в диалоговом окне – вкладка вида страницы. По 

умолчанию календарь будет создан соответственно размеру открытого в CorelDRAW документа. 

Сняв галочку в окошке «Создать календарь в настоящем документе», вы можете ввести любой 

размер. Справа отражаются настройки параметров страницы. 

Выбрав вкладку «Большой заголовок», вы можете настроить шрифт, цвет, фон, границы и размеры 

блока с заголовком, а также выбрать, будет ли отобра- 

жаться год или нет. Точно так же можно изменить шрифт, цвет, фон, границы, стиль и 

расположение текста остальных заголовков. Так, по умолчанию воскре- сенье выделено красным. 

Вы можете изменить цвет и шрифт любого выбранно- го объекта (рис. 34). 

 
 

Рис. 34. Вкладка «Большой заголовок». 

 

 

Открыв вкладку «Большой корпус», продолжаем настраивать наш кален- дарь. Начнем с 

направления календаря, затем настроим шрифт, цвет шрифта, фон, границы, разделители и 

расположение дат. Лунные фазы по умолчанию отображаются; кроме того, можете взять каждую 

дату в клеточку (рис. 35). 

 
Рис. 35. Вкладка «Большой корпус». 

 

 

Выберите также день недели, который будет выделен цветом; выделить можно также праздники. 

Если вы решите так и поступить, то не забудьте вы- брать также цвет и шрифт для выделения дат 

(по умолчанию установлен крас- 

ный цвет). Можно также отобразить названия праздников на календаре, а также определить для 

них цвет и шрифт. 

Нам осталась еще одна, последняя настройка на вкладке «Вид страницы». Здесь вы можете 

сохранить Стиль форматирования. Так, если вы хотите создать комплект настроек, которые будете 

использовать в дальнейшем, нажмите на кнопку «+» и сохраните стиль на будущее. Когда стили 

будут созданы, они бу- дут появляться в выпадающем списке, и вам останется только выбрать 

нужный для данной работы стиль. 

Установив все настройки, нажмите на кнопку «Сгенерировать» в верхней части окна, и календарь 

создастся автоматически (рис. 36). 
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Рис. 36. Настольные календари. 

 

Практическая работа  

Цель – приобретение навыков создания и обработки текста. 

Задача – создать визитку. 

Порядок выполнения упражнения: 

Создайте новый файл File > New (Файл>Новый): Размер визитной карточки 90х50 мм. 

Цветовой режим – CMYK. 

Разрешение – 300 dpi. 

Примечание. Графика визитной карточки должна иметь зазор в 2 мм с каждой стороны. На самой 

визитке важные элементы нельзя располагать бли- же, чем на 2 мм к линии реза (рис. 37). 

 

 

Рис. 37. Границы визитной карточки. 

 

 

Выберите инструмент Rectangular (Прямоугольник) и нарисуйте про- извольный квадрат. 

Выделите квадрат и залейте его окантовку черным цветом. Настройте размеры квадрата: 94х54 

мм. Нажмите «Enter». Разместите полу- чившийся прямоугольник по центру рабочей области, 

выполнив команду Arrange > Align and Distribute > Center to Page (Упорядочить> Выровнять и 

Распределить> Центрировать на странице) или нажмите на клавиатуре клави- шу «P». 

Создайте еще один прямоугольник, проделайте с ним все тоже самое, но окрасьте его контуры в 

другой цвет, а размеры поставьте 86х46 мм. Это и есть безопасная область визитной карточки 

(рис. 38). 
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Рис. 38. Построение визитки. 

 

 

Откройте Менеджер объектов Windows > Docker > Object Manager (Окна> Окна настройки> 

Диспетчер объектов). Щелкните по оранжевому пря- моугольнику, вы увидите, как он высветится 

в Менеджере объектов. Перетяни- те его из категории Layer 1 (слои 1) в категорию Guides 

(Направляющие). Та- ким образом, мы превращаем его в направляющую. Если все правильно, 

контур прямоугольника окрасится синим, а прямоугольник не появится на печати, зато будет 

постоянно на глазах и точно останется в зоне безопасности, когда вы бу- дете рисовать графику 

для визитки. Не забудьте кликнуть по нему правой кнопкой мыши и из меню выбрать Lock Object 

(Блокировка объекта) – прямо- угольник будет невозможно случайно сдвинуть или удалить (рис. 

39). 

 

 
 

 

Рис. 39. Менеджер объектов. 

 

 

Разработайте дизайн визитки. Оформите текст на визитке: укажите фа- милию, имя, отчество или 

название фирмы; должность или направление дея- тельности; адрес и телефон; логотип. 

Переведите текст в кривые Arrange > Convent to Curves (Упорядочить > Преобразовать в кривые), 

либо нажмите клавиши «Ctrl+Q» (рис. 40). 
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Рис. 40. Пример выполнения визитки. 

Практическая работа 

Цель – закрепление навыков создания и обработки векторных объектов. 

Задача – создать обложку книги. 

Порядок выполнения упражнения: 

Создайте прямоугольник шириной 130 мм, высотой 205 мм – будущую обложку книги. Залейте 

его цветом. 

Создайте переплет книги – прямоугольник шириной 20 мм, высотой 205 мм. Повторите процедуру 

заливки. 

Теперь создайте дизайн обложки и добавьте текст (рис. 41а). Сгруппи- руйте отдельно элементы 

обложки книги и отдельно элементы переплета. При выделении объектов удерживайте клавишу 

«Shift». 

Сместите переплет, как показано на рис. 41б. Чтобы повернуть объект, щелкните и перетащите 

угловой маркер поворота. 

Сместите обложку книги, как показано на рис. 41в. 

 

Рис. 41. Дизайн обложки книги. 

 

 

Отмените группировку объектов. Создайте копию прямоугольника ши- риной 20 мм, высотой 205 

мм и сместите, как показано на рис. 42а. 

Создайте несколько страниц книжки. Для этого нарисуйте прямоуголь- ник шириной 130 мм и 

высотой 20 мм. Залейте его цветом, схожим с цветом книжных страниц. Трансформируйте его, как 

показано на рис. 42б. Добавьте 

тени (рис. 42в). 
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Рис. 42. Окончательная обложка книги (автор: студент 487 гр. В. Песковец). 

 

 

На рис. 43 представлены варианты оформления обложки книги. 

 

 
 

 

Рис. 43. Варианты оформления обложки книги. 
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